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Support
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HP Software Solutions Now accesses the HPSW Solution and Integration Portal Web site. This site enables you to explore HP Product Solutions to meet your 
business needs, includes a full list of Integrations between HP Products, as well as a listing of ITIL Processes. The URL for this Web site is 
http://h20230.www2.hp.com/sc/solutions/index.jsp
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What's new in this release
This section describes the important changes in this release. 

Tip: As of Service Manager 9.33, the "Installation Information" section of the patch detail page 
will contain a link to a knowledge base article that contains links to all the previous release 
notes and patches. This article enables you to always find the most up-to-date release notes 
and the latest 9.3x patches:

http://support.openview.hp.com/selfsolve/document/KM00705452

Web client improvement
In the Service Manager Windows client, if you select the "Show context-sensitive help debug 
information" option in the Preferences and try to view the description information of a field, it shows 
not only the field description information but also the debug information such as the field name as it 
exists in the database. Prior to  Service Manager 9.33p2, the Web client has no way to show the 
field names.  See "QCCR1E99915" on page 8.

To improve this situation, a new parameter, viewcontexthelp, was introduced in the Service 
Manager 9.33p2 release. In the HP Service Manager Web client, if you append 
"viewcontexthelp=true" to the URL and view the field help information of a field, it shows both the 
field description information and the debug information such as the field name as it exists in the 
database. See "Web parameter: viewcontexthelp" below.

Note: The parameter of viewcontexthelp is only supported in the Power User mode (index.do) 
and Self-Service User mode (ess.do), and is not supported in the other two Accessible modes 
(accessible.do and accessible-ess.do).

Web parameter: viewcontexthelp
Web parameters change the behavior of Web clients connecting to the Web tier. You can set some 
of these parameters from the Web client login URL, some from the Web tier configuration file 
(web.xml), and some from both.

Parameter
viewcontexthelp

Description
This parameter enables the Web client to display the same context-sensitive help debug 
information (field) in field help as the Windows client does. To enable this feature, append 
"viewcontexthelp=true" to the Web client URL.

Note: This feature is only supported  in the Power User mode (index.do) and Self-Service 
User mode (ess.do), and is not supported in the other two Accessible modes 
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(accessible.do and accessible-ess.do).

Valid if set from
Web client URL

Requires restart of Web application server?
No

Default value
false

Possible values
true or false

Example usage
http://myhost:8080/index.do?viewcontexthelp=true     

Mobility performance improvement
Prior to  Service Manager 9.33p2, if you use handsets with lower performance such as Blackberry 
7.x, the Service Manager Mobility browser hangs  and the "Loading..." page is displayed forever 
when you are trying to view the detail of a Change record in the Service Manager Mobility. See 
"QCCR1E103594" on page 13.

Here are the known issues and the best practices for low performance handsets:

 1. You are recommended to customize your .mobile forms, so there are only limited Tabs in the 
detail form and limited fields in each Tab. For example in OOB system, the browser may hang 
when you try to view the detail of a record if the number of Tabs is greater than 10. 

 2. In the detail view of a record, if you tap an inactive Tab, the contents in the Tab may be shown 
with about 1 to 3 seconds delay .  

 3. If an operation results in the switching from the detail view to the list view (for example, filling in 
a field through a Comfill button), better set a small "recordlistcount" value in the web.properties 
file so as to make the operation successful. 

 4. If an operation results in the reloading of the current detail view of a record ( for example, saving 
a record without filling in all mandatory fields ), better keep the number of Tabs to less than 3 so 
as to make the operation successful. 

 5. In the case of saving a record without filling in all mandatory fields, it may not function correctly 
even if there are less than 3 Tabs. For example, the focus may not jump to the target 
mandatory field or the target inactive Tab may be still inactive. In this case, you need to 
manually find out the mandatory field Tab by Tab and set a value for it.

Handsets related log information available
Handsets related log information is available from Service Manager 9.33p2 in the perf.log file in the 
Service Manager Mobility, when the parameter remote.log is set to true in the WEB-
INF\classes\META-INF\app.properties file. See "QCCR1E103596                     " on page 13.
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 Mobility supporting Service Manager 9.31 with 
PDCP4

If you have the PDCP4 with the Mobility Applications installed on the same server, the mobile 
function is not compatible with the PD4 function and they will not work correctly together. See 
"QCCR1E103595" on page 13.

If you are using Service Manager 9.31 with PDCP4 installed, you need to configure Service 
Manager to implement the Mobile Applications by importing the mobile2-new-9.31-pd4.unl 
unload file when it is required. You also need to load the mobile2-new-9.31-pd4.unl unload file to 
add support for the Service Manager Mobile Applications.

For more information about how to install the Service Manager 9.33  Mobility client, refer to  the 
Service Manager 9.33 Mobile Applications User Guide.

Open Localization Toolkit support for Service 
Manager 9.33

The HP Service Manager Open Localization Toolkit enables HP partners to localize Service 
Manager and Service Request Catalog (SRC) for Service Manager into non-supported languages. 
Service Manager 9.33 patch 2 provides the setupLP_SM_933.xml file, the Language Builder 
configuration file specific for Service Manager 9.33 version. See "QCCR1E105667" on page 13. 

For more information, refer to  the HP Service ManagerOpen Localization Toolkit User Guide.
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Enhancements
This release includes the following enhancement type fixes.

CR Module Problem Solution

QCCR1E99915 Web 
Client 

In the Service Manager Windows client, 
if you select the "Show context-
sensitive help debug information" option 
in the Preferences and try to view the 
description information of a field, it 
shows not only the field description 
information but also the debug 
information such as the field name as it 
exists in the database. But in the Web 
client, there's no such option and it 
shows the field information only.                                              

In the Service Manager 
Web client, if you append 
"viewcontexthelp=true" 
to the URL and view the 
field help information of a 
field, it shows both the 
field description 
information and the 
debug information such 
as the field name as it 
exists in the database. 
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Fixed defects
This release fixes the following defects.

Server

CR Problem Solution 

QCCR1E70925  When the views under the "group 
by" feature are refreshed or initially 
displayed, the first group is 
automatically expanded after 
upgrading to Service Manager 
7.11.410 (Patch 17) in the Web 
client.

Now the To Do queue groups will 
not be automatically expanded 
when you switch between queues 
or views.      

QCCR1E100977 The "Maximum number of 
application tabs exceeded" 
message displayed to the user is 
not localized.

The "Maximum number of 
application tabs exceeded" 
message displayed to the user is 
localized.

QCCR1E101306 IR regen takes too long and it is 
performed as SYNC mode. 

Replace IR regen with ASYNC 
mode, and increase the throughput 
of the IR queue process.

QCCR1E101744 Error messages such as "RTE E 
STRING is not null 
terminated!!!" exist in the log. 

The error messages do not exist in 
the log now. 

QCCR1E101756 When you open the format 
sc.manage.problem.g, all the 
assignment groups are returned in 
the soap response twice.

The assignment groups will not be 
returned in the soap response if the 
value list equals to the display list.

QCCR1E102310 The "search" function on the 
Service Catalog screen is 
inaccurate in a case sensitive 
database.  

The IR search results are now 
consistent between case sensitive 
and insensitive databases. 
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CR Problem Solution 

QCCR1E102418 After you apply PDCP4 (according 
to Applications Patch manager 
Guide for Content Packs (from 
June 2013), Step 8 of chapter 
"Applying the Content Release" on 
page 16) and stop the Windows 
service, a core dump is generated 
and the following error is reported 
to the log file.

3164( 5612) 12/04/2013 
12:49:30 RTE E !!! 
SCException Win32 Exception: 
0xC0000005 (instruction 
0x100F1D12 while reading 
address 0x0AC07744) caught 
in system!!!  

The error will not occur when you 
apply PDCP4 and stop the 
Windows service now.

QCCR1E103808 When you rename an assignment 
group by using a javascript, the 
new name cannot be found by 
exact match search.

When you rename an assignment 
group by using a javascript, the 
new name can be found by exact 
match search.

QCCR1E104099 Service Manager leaves some 
SCAGW files in the var/tmp 
directory on all the three LINUX 
APP servers. These files are in 
"deleted" state and are removed 
only when the Service Manager 
process is stopped. 

Now these temporary files are 
removed clearly and immediately 
once they are not needed.

QCCR1E104364 After you upgrade the Service 
Manager Server to 9.32.p2, the old 
record value in the activity table is 
changed.

The old record value after the 
upgrade is the same as the value 
before the upgrade.

QCCR1E104338 Capabilities missing occurs after 
you add a capability word to a new 
ess user. 

No capabilities missing occurs 
after you add a capability word to a 
new ess user.

QCCR1E104514 Service Manager keeps reading 
the computer CI even though it 
has reached the end of the file, 
which may result in some 
duplicate records.

When Service Manager reaches 
the end of the computer CIs,  it 
stops reading the file and then 
returns. No duplicate records are 
returned.
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CR Problem Solution 

QCCR1E104872 The warning message for sqlupper 
is not clear. 

More information about sqlupper 
usage has been added in the 
warning message.

QCCR1E104868 When the user attempts to open a 
change after the load of Process 
Designer 9.30.06, the following 
SQL error is displayed.

SQL code=904 message=ORA-
00904: "GROUPED_DATA"."COUNT
(*)": invalid identifier

No SQL error is displayed when 
the user opens a change after the 
load of Process Designer 9.30.06.

QCCR1E105483 When you operate the following 
SQL queries, Service Manager 
scans the full table and this results 
in the performance degradation.

SELECT * FROM SCHEDULEM1 
WHERE UPPER("SCHEDULE_ID")= 
:Y

The SQL statement that Service 
Manager generates has been 
optimized to avoid the full table 
scan.

QCCR1E105515 When you are creating a new 
change in the Web client, the 
change category and the first 
subcategory are expanded, and 
the first change type is pre-
selected.

Now the "change category" will not 
be expanded until one list item is 
selected by the user. This is the 
change which also affects those 
tab windows brought up by 
"Change management > Change 
Queue" or "Incident management 
> Incident Queue" menu items.

QCCR1E105665 In sqlupper mode, if you use 
grouping, inefficient query resulted 
by performance degradation 
occurs when group number grows. 

Using grouping in sqlupper mode 
improves query efficiency without 
performance degradation now.

QCCR1E106190 JGroups report the "failed to 
collect all ACKs" error and the 
system is unstable. 

JGroups do not report the "failed to 
collect all ACKs" error and the 
system is more stable now. 

QCCR1E106486 The dashboard (chart) pages 
cannot be refreshed every 60 
seconds and the "refresh" button 
does not work in the Windows 
client.  

Service Manager updates the 
dashboard data in real-time 
manner now, so that the 
dashboard (Chart) pages are 
refreshed every 60 seconds and 
the user can also click the 
"refresh" button to update the 
dashboard in the Windows client.
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CR Problem Solution 

QCCR1E106458 When you operate the following 
SQL queries, Service Manager 
scans the full table and this results 
in the performance degradation. 
This is because Service Manager 
cannot handle RECORD_KEY 
data type correctly.

SELECT * FROM SYSLOGM1 WHERE 
UPPER("RECORD_KEY")= :Y

The performance degradation does 
not exist now. 

Web client

CR Problem Solution 

QCCR1E103851 HTML Viewer does not 
dynamically refresh when you 
switch between tabs in  the web 
client.

HTML Viewer can dynamically 
refresh when you switch between 
tabs in  the web client.

Windows client

CR Problem Solution 

QCCR1E103023 In the Windows client, when the 
cursor is positioned in the Journal 
field of an Interaction, if you switch 
to another window/program and 
then switch back, the Journal field 
scrolls down to the bottom.

In the Windows client, when the 
cursor is positioned in the Journal 
field of an Interaction, if you switch 
to another window/program and 
then switch back, the Journal field 
remains unchanged and will not 
scroll down to the bottom.

QCCR1E103369 If you modify the value of a cell in 
a Table in the Windows client, the 
original value is displayed after the 
cell loses focus. 

Now if you modify the value of a 
cell in a Table in the Windows 
client, the new value is displayed 
after the cell loses focus. 

QCCR1E104031 In the Windows client, only the 
value of the last modified Comfill 
is saved in each row in the unload 
script utility. 

In the Windows client, all values of 
modified Comfills are saved in 
each row in the unload script 
utility.                                              

QCCR1E107188 During a normal operation, the 
Windows client hangs due to the 
memory usage increase.

The memory is ensured to be 
released properly to avoid the out 
of memory error, so that the 
Windows client doesn't hang. 
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Mobility

CR Problem Solution 

QCCR1E103594 The browser hangs in Blackberry 
OS7.1 based devices and the 
"Loading..." page is displayed 
forever when you are trying to view 
the detail of a Change record in 
Service Manager Mobility. 

Now it is successful for you to 
view the detail of a Change record 
in Service Manager Mobility.   

QCCR1E103596                     Handsets related log information is 
unavailable in the perf.log file in 
the Service Manager Mobility, 
even if the parameter remote.log is 
set to true in the WEB-
INF\classes\META-
INF\app.properties  file. 

Handsets related log information is 
available in the perf.log file in the 
Service Manager Mobility, after the 
parameter remote.log is set to true 
in the  WEB-INF\classes\META-
INF\app.properties  file.

QCCR1E103595 In a Service Manager 9.31 system 
with PDCP4, if you install Mobility 
Applications on it, the mobile 
function or the PD function will not 
work correctly.

In a Service Manager 9.31 system 
with PDCP4 installed, after you 
install Mobility Applications on it, 
both the PD and the mobile will 
work correctly now.

Open Localization Toolkit

CR Problem Solution 

QCCR1E105667 Custom Language Builders does 
not work when you use Language 
Builder, an HP tool, to build 
custom Language packs. 

When trying to run custom 
language builders - the installers 
can't find JRE and also stop in the 
middle. This is part of the custom 
web build that is done for every 
new web binary release.

An updated Language Builder 
configuration file  is provided for 
Service Manager 9.33 version. 
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Known problems, limitations, and 
workarounds

This software release has the following known issues and limitations. This is a cumulative list of 
known issues and limitations in Service Manager, including those that are already documented in 
previous release notes (Service Manager 9.32 and patches, and Service Manager 9.31 and 
patches).

Issues  in Service Manager 9.31 and patches

Global ID Problem Workaround

QCCR1E63663 The Service Manager client loses 
connectivity during JavaScript 
execution of the file.list RAD 
application.

No workaround available.

Created a knowledge article 
(KM1166532), which states that 
Service Manager does not currently 
support calls from JavaScript on 
RAD applications that use the 
rio/fdisp panels.
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Global ID Problem Workaround

QCCR1E57385 When Service Manager is running on 
Unix, the legacy listener may log 
intermittent signal 11 upon CIT initial 
connectivity test if exec-shield is not 
set properly.

Use one of the following solutions to 
solve this issue on Unix.

Solution 1:

Connect Connect-It to the Web 
Services connector instead of the 
Legacy Listener connector.

Solution 2:

Before connecting Connect-It to the 
Legacy Listener connector, do the 
following:

 1. Add  usethreading:0 in the sc.ini 
file, which is located in <Service 
Manager server installation 
path>\LegacyIntegration\RUN.

Note: For 64-bit RedHat Linux 
servers only, you can 
alternatively run the following 
shell commands as root:

# sysctl -w kernel.exec-shield=0

# sysctl -w kernel.randomize_
va_space=0

 2. Start the legacy listener.

Patch 2 Release Notes
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Global ID Problem Workaround

QCCR1E67491 When the collation of the db instance 
is Chinese_PRC_BIN, Web service 
clients fail to connect to Service 
Manager. Only ASCII operator 
names are supported, so only ASCII 
operator names can be used. 

Note: This issue only exists in Web 
service integrations. Therefore, the 
Service Manager clients do not have 
this problem.

When Service Manager is handling 
an incoming SOAP request, the 
authorization string is decoded by 
BASE64Decoder. Service Manager 
uses the decoded string value to 
construct a UTF-8 string that is used 
in the RTE. However, the 
authorization string is in the header 
and Service Manager does not know 
the charset or encoding of the 
underling string value, which is 
BASE64 encoded. 

Therefore, if the underlying string 
value is not UTF-8, this problem will 
occur. In Service Manager, when 
fetching an operator record from the 
database, no matter what collation 
the database uses, the operator 
record finally will get a UTF-8 
operator value. However, even if 
users put the same value in the 
authorization header, the operator 
name may differ because of the 
charset/encoding issue. Because of 
this, the operator will fail to log on.  

This is a limitation of Service 
Manager. Do not use non-ASCII 
characters in operator names. 
Created a knowledge article 
(KM1442479) to document this 
limitation. 

QCCR1E75182 HTML email truncates the body of 
the message and sends the HTML 
code without translating it.

When the content of an HTML email 
template exceeds 8192 bytes in size, 
the content will be truncated and 
displayed as HTML code.   

Make sure your HTML email 
templates do not exceed this size 
limit.
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Global ID Problem Workaround

QCCR1E77563 Signal 11 error is received when 
calling the toXMLString() routine of 
the Users object. 

No workaround is currently available.

QCCR1E88222 An unload file that is exported from 
an Oracle to an SQL Server database 
fails to import when the unload file 
already contains a RECORD_KEY 
field and the length of first unique key 
exceeds the db limitation.

This request is caused by the product 
running in an unsupported 
configuration. Change to a 
documented and supported 
configuration. If the problem still 
exists in a supported environment, 
contact HP Support.

To work around this issue, do not use 
"RECORD_KEY" as a SQL Name 
for a field in dbdict.  This field name is 
reserved by Service Manager.  To do 
this, follow these steps:

 1. Enter dbdict in the Service 
Manager command line box.

 2. Enter "esdquestions" in to the 
search field, and then click the 
Search button.

 3. Select the "record.key" field, and 
then change the SQL Name from 
"RECORD_KEY" to anything 
else.

QCCR1E74808 After clicking the Cancel button in 
the Condition Editor from the 
Workflow Editor, the current tab 
sometimes becomes a blank screen 
and the tab cannot be closed.

No workaround is currently available.

QCCR1E105052 In Task Planner, the tooltip of a task 
displays the change phases with 
their names instead of their display 
names.

No workaround is currently available.
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Issues  in Service Manager 9.32 and patches
Service Manager  Issues

Global ID Problem Workaround

QCCR1E64377 In the web client, when a 
Configuration Item (CI) record is 
opened, the CI label does not show 
(or only shows for the first time) in 
the CI Visualization (Relationship 
Graph). This issue occurs only when 
JRE 6 is used.

As Oracle has fixed this Applet 
issue, JRE 6 customers need to 
upgrade their JRE to the latest JRE6 
or JRE7 on the machine that runs 
Internet Explorer or Firefox in order 
for CI Visualization to display CI 
labels correctly.

QCCR1E95725 Due to a known issue in JDK (bug 
id:7196513), CI icons are not 
displayed correctly in Firefox when 
Httponly cookies are enabled in the 
web application server. 

When Httponly cookies are enabled, 
users can only use Internet Explorer 
7 or higher for CI icons to display 
correctly.  As Oracle has fixed the 
Httponly cookie issue as of JDK 7u6, 
users need to install the latest 32-bit 
JRE (7u6 or above) on the machine 
that runs Internet Explorer 7 or 
higher. 

Note: In Service Manager 9.33,  
users can only use Internet 
Explorer 8 or higher for CI icons 
to display correctly.

QCCR1E95963 An error occurs when loading a 
dbdict twice in an unload file. The 
two dbdict records have the same 
name, but different key types:  the 
first one has unique key, while the 
second's key type is primary key. 

Do not export to an unload file a 
dbdict record whose key type has 
changed. 
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Global ID Problem Workaround

QCCR1E97260 When SSL is enabled between the 
web application server and Firefox, a 
ClassNot found Exception error 
displays in the workflow section of 
the Change form. This issue does 
not occur in IE or in Firefox without 
SSL enabled.

There are two workarounds:

 l Use Internet Explorer instead of 
Firefox. 

 l If using Firefox, import the client 
certificate into the Java console 
on the end user's machine. Here 
are the steps for Windows 7:

 a. Open Control Panel, and i n 
the Control Panel Search box 
enter "Java Control 
Panel".

 b. Double-click the Java console 
icon to open the Java console.

 c. On the Security tab, click 
Manage Certificates ....

 d. On the Certificates window, 
select certificate type: Client 
Authentication, and click 
Import.

 e. Follow the wizard and import 
the client user's certificate.

QCCR1E97492 Clicking the Back button on the CI 
Visualization page (which opens 
when you click More > Expand CI 
Visualization  in a CI record) causes 
a Firefox crash.

No workaround is currently available.

QCCR1E97603 If a format that contains a button with 
Enable condition is created or 
modified by using a Service Manager 
9.31 patch 1 server, when using it in 
Service Manager 9.31 GA or earlier, 
the client crashes. However, formats 
created by using the Service 
Manager 9.31 GA or earlier server 
work fine.

Upgrade both of the Service Manager 
server and client to the same patch 
level: Service Manager 9.31 patch 1 
or later.

QCCR1E94657 When PDCP4 is applied, the first 
group on the form is not shown in the 
Jump Address drop down list.  

Move the scroll bar to the top-most 
position and then you will see the first 
group.

Patch 2 Release Notes
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Global ID Problem Workaround

QCCR1E97856 In a single-line text field, some 
special characters whose HTML 
code is &#x...; (where ... stands for 
a hex number) are not represented as 
their original format. Instead, they 
display as &#x...;. However, such 
characters are represented as the 
original format in other widgets 
(textarea, label, message panel, and 
so on).

No workaround is currently available.

QCCR1E93604 The HTTP Response Code is 200 
instead of 400 when a RESTful 
request uses an invalid sort field 
separator (for example, a plus 
symbol).

Use a valid sort field separator. 

QCCR1E94204                     Because of the incorrect status, the 
operation could not proceed after 
merging a record.

Reset the status of this record (for 
example, reopen the closed record) 
and perform the last operation again.

QCCR1E94206 The last operation could not be 
repeated after merging a record 
because the  button for the last 
operation disappears. 

Reset the condition for the button in 
this record, for example, Reopen the 
closed record, and perform the last 
operation again.

QCCR1E96353 RESTful API: An incident record is 
successfully resolved when posting 
an incident resolve action with a 
blank "ClosureCode" and "Solution".

Validation is not performed for the 
fields. 

To work around this issue, validate 
them at the RESTful client side, or    
manually add validation for the fields 
to the format control.

QCCR1E96391 Restful API: Results are in the wrong 
order when sorted by an array field.

This issue occurs because the  
Service Manager RTE does not 
support sorting by array fields. A list 
is returned without any error 
message.

No workaround is currently available.
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Global ID Problem Workaround

QCCR1E97898  Restful API: A 400 Bad Request 
error occurs when a RESTful API 
request is a cross-table join query.

The RESTful API framework 
supports simple queries and Service 
Manager native queries.  

Currently RESTful API framework 
does not support cross-table SQL 
queries.   

QCCR1E98320 When a record is removed after being 
read, the Merge function still allows 
the user to merge the record and the 
user's input is lost. 

No workaround is currently available.

QCCR1E98227 In Approval Delegation wizard, go to 
another page (do not change the 
delegation module) after choose the 
operator to delegate in "Select 
Approval Groups" page, then back to 
"Select Approval Groups" page 
again. You will find a blank line is 
displayed in the right table, instead of 
the operator record.  

This is only a display issue, and will 
not impact the functionality.  If you 
need to remove the operator from the 
delegation list, choose the blank line, 
and then click the remove icon; 
otherwise the operator will be 
successfully delegated once you 
save the update. 

QCCR1E98576 When there are conflicted updates on 
system fields, the system displays 
the message "The conflicted fields 
cannot be merged. Reload the 
record.", whereas the Merge  button 
is available. Actually, the merge 
function should not be available in 
such case. 

Ignore the Merge button. Reload the 
latest record to edit this record again.

QCCR1E98398 When you are updating a record and 
adding attachments to this record, if 
your updates conflict with another 
users' updates or the updates of a 
background process, the 
attachments will be lost after either 
automatic or manual merge.

After automatic or manual merge, 
add the attachments again before 
saving the merged result of the 
record.

QCCR1E98411 SRC failed to retrieve service 
catalog items from Service Manager 
on upgrade from Service Manager 
7.11 to Service Manager 9.32.

In the svcCatalog dbdict, the 
id.attach field is character type, 
which should be number type. The 
id.attach field is an alias of the id field 
in the svcCatalog table.

To fix the issue, change the field type 
using the Dbdict Utility.
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Global ID Problem Workaround

QCCR1E98618 Subcategory data on the Incident 
form is not available after upgrading 
from ServiceCenter 6.2 to Service 
Manager 9.32.

Subcategory data is not upgraded.

If necessary, manually add the 
subcategory data.  

 1. Enter db in the Service Manager 
command line box.

 2. In the Table field, enter 
subcategory, and click 
Search. 

 3. For each Catagory in the 
dropdown list, add the following 
Areas (enter a value in the Area 
field and click Add):  access, 
data, failure, hardware, 
performance, and security.

QCCR1E98475 With Process Designer Content 
Pack 9.30.3 applied, the Merge 
functionality does not work when a 
user clicks Save & New in an 
interaction record opened through a 
search. 

 1. Open an interaction through a 
search.

 2. Update the Title.

 3. Another back-end process has 
updated the Title to another 
value.

 4. Click Save & New. An error 
occurs: This record has 
changed since you selected 
it.

You cannot perform Merge for 
the conflicted updates as 
expected.

If you encounter the error "This 
record has changed since you 
selected it." when clicking the Save 
& New button on an interaction 
opened through a search, to avoid 
abandoning your updates, do not use 
the Save & New button to save your 
updates; instead, first click the Save 
button to save your updates with the 
merged result, and then register a 
new interaction from the navigation 
menu.
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Service Request Catalog Issues

Global ID Problem Workaround

QCCR1E90074 When entering a search string in 
Service Request Catalog, auto-
complete does not work if the 
browser's preferred language is set 
to an East Asian language (for 
example, Simplified Chinese).

No workaround is currently available.

QCCR1E98339 Custom fields do not load the 
DEFAULT company value when the 
checkout panel is empty for one of 
the three checkout panels of your 
company.

After upgrade, you should manually 
add the same structure configuration 
of the DEFAULT company for the 
empty checkout panel of your 
company. For example, before 
upgrade, you, as an SRC 
administrator, only defined custom 
fields for the Service Catalog 
checkout panel for your company. 
After upgrade to Service Manager 
9.32, if you want to use the support 
checkout panel and generic support 
checkout panel in SRC correctly, you 
need to manually add OOB 
configurations for the Support 
Catalog  and Generic Support 
checkout panels, which you can 
copy from those panels of the 
DEFAULT company.

QCCR1E103491 When SRC starts in FIPS mode, 
JCE cannot authenticate the provider 
JsafeJCE.

Replace cryptojce-6.1.jar and 
cryptojcommon-6.1.jar in the SRC 
.war files with those from the 
encryptor tool folder in the same 
release package.

Issues  in Service Manager 9.33 and patches

Global ID Problem Workaround

QCCR1E100136 After the installation of a language 
pack, the Windows client, if running 
on an Arabic Windows 2008, 
displays the tooltips of the 'Added' 
and 'Forced'/'Updated' columns in 
the content pack results as reversed. 

No workaround is currently available.
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Global ID Problem Workaround

QCCR1E101782 In Trusted Sign-On (TSO) mode, if 
users log in to the web client with 
Simplified Chinese in Internet 
Explorer 10 running on Windows 8 or 
Windows 2012, the web client still 
displays in English instead of in 
Simplified Chinese.

No workaround is currently available.

QCCR1E103847 An arrow connector in a Process 
Designer workflow might be 
misaligned when the destination 
phase is vertically too close to 
another phase (this problem was 
introduced in Service Manager 9.33 
patch 1 revision 1).

To resolve the issue, move the 
destination phase away enough from 
the adjacent phase.

QCCR1E103858 It displays auto-open tasks in the 
task planner window  (this problem 
was introduced in Service Manager 
9.33 patch 1 revision 1).

No workaround is currently available.
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Backup and backout instructions
In case you need to restore your Service Manager system to its original state after installing the 
component patches in this release, make necessary backups before each patch installation. If a 
rollback is needed, follow the backout instructions.

Server
Backup

Before you apply the server patch, make a backup of the server installation folder. For example, 
C:\Program Files\HP\Service Manager 9.30\Server.

Note: If you have a horizontally scaled system, be sure to back up the server installation folder 
for each server instance.

Backout

Service Manager  has supported FIPS mode since version 9.32. To run Service Manager in FIPS 
mode, you must upgrade your database to the 256-bit AES encryption algorithm. Once you change 
all of the encrypted fields to use the new 32 character encryption you cannot roll back the RTE and 
still read the encrypted data.

After installing the patch, do the following to backout:

 1. Stop the Service Manager server.

 2. Remove the existing server installation folder.

 3. Copy the backup folder back.

Note: Make sure that the embedded Tomcat is also replaced with the backup, because 
the version of the embedded Tomcat may have dependency on a specific server version.

Note: If you have a horizontally scaled system, make sure that every server instance is 
replaced with its  backup.

 4. If you have also loaded platform unload files required for your server changes, you must also 
roll back the application changes made by the unload files. See "Applications" on page 27.

 5. For Unix-based platforms other than Linux, make a backup of your JRE if you have not yet 
upgraded to JRE 1.7. 

 6. Restart the Service Manager server.
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Web Tier
Backup

Before deploying the new web tier, make a backup of the following items:

 l web.xml file

 l application-context.xml

 l log4j.properties

 l splash screen

 l style sheets

 l any other customizations you made, including your webtier-<version>.war (webtier-ear-
<version>.ear) file.

Backout

To roll back to the old web tier:

 1. Delete or uninstall the existing web tier.

 2. Clear the cache of your web application server (for example, Tomcat).

 3. Redeploy the old web tier.

 4. Restore your old customizations.

Windows client

Backup
 1. Make a backup of your Windows client home folder, for example, 

C:\Users\<username>\ServiceManager. Your connections and personalized settings are 
stored in this folder.

Note: This is the out-of-the-box home directory, and could differ from yours if you made 
changes  to <Client>\configuration\config.ini file. If so, back up the files from the 
location specified in that file.

 2. Make a backup of your certificate configuration files if any (Window > Preferences > HP 
Service Manager > Security). For example, your CA certificates file and client keystore file. 
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Backout
 1. Uninstall the new Windows client.

 2. Reinstall the previous Windows client.

 3. Restore your old Windows connections and configurations.

Applications
If you plan to upgrade your applications to this release level, make a backup of your database 
before the upgrade, in case you need to restore your database after the upgrade. Creating a backup 
of the entire database and restoring the database if needed is a better approach for a full 
applications upgrade.

If you plan to load individual unload files in this release, follow the backup and backout instructions 
below.

Backup

Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are 
recommended to use Unload Manager to make a backup of the files to be modified by an 
unload file, because Unload Manager can create a backup of your old data during the 
installation of the unload; if your application version is other than any of these, Unload Manager 
is not available and you can use Database Manager instead. 

To use Unload Manager to make a backup:

 1. Go to System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details 
of the unload file appear.

 4. Double-click a conflicting object in the table to open the merge tool:

 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to go back to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the unload.

 7. Click Finish. 

Now, the unload has been applied and at the same time your old data backed up.

To use Database Manager to make a backup:
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 1. Go to Database Manager, select Import/Load from More or the More Actions menu, and 
browse to the unload file.

 2. Click List Contents on the menu bar, to view a list of files that have been updated in this 
unload.

See the following figure for an example.

This figure shows the contents of an unload file that contains changes to the following files:

File Record

Process     svc.add.cart

application money.format

Note: The scmessage records listed under each RAD application are 
messages used in this RAD application; no backup is needed for them.

ScriptLibrary svcCartHelper

datadict activity

dbdict activity

Note: The “activity” file with no records actually represents the dbdict 
record of the activity file.

scmessage The record whose message class is “fc” and message number is 1000. 
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 3. Go to Database Manager, in the Table field enter a file name you got in step 2, and click the 
Search button.

 4. If the format selection page shows, select the proper format by double-clicking it (for example, 
select the device format for the device file), and then search for the file record.

 5. Click More (or the More Actions menu) > Export/Unload after the file record displays.

Note: If Export/Unload is not available, check the Administration Mode check box in 
Database Manager and try again.

 6. In the pop-up window, specify your backup upload file path/name, and click Unload Appl. 

Caution: Make sure that Append to file is selected.

 7. Repeat steps 3 through 6 to back up the rest of the files you got in step 2.

Backout

Tip: You can use Unload Manager (recommended) or Database Manager (if Unload Manager is 
not available in your application version) to roll back to your old data, as described in the 
following.

To roll back to your old data using Unload Manager:

 1. Go to  System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file generated in the backup process, specify a backup file, and then click 
Next. Details of the unload file display.

 4. Double-click a conflicting object in the table to open the merge tool:
 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to return to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the backup unload.

 7. Click Finish.

To roll back to your old data using Database Manager:
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 1. Go to Database Manager, click More > Import/Load.

 2. Browse to the backup unload file you created.

 3. Click Load FG.

Knowledge Management Search Engine
To back out your Knowledge Management (KM) search engine changes, make a backup before 
your KM patch installation.

Note: Keep in mind that you also need to roll back KM-related server side and application side 
changes. For details, see the Server and Application backup and backout Instructions.

Backup
Before applying the KM patch and upgrading the JDK and KM embedded Tomcat, do the following:

 1. Make a backup of the search engine installation folder. For example, C:\Program 
Files\HP\Service Manager 9.30\Search Engine Backup

 2. Make a backup of the files to be modified by the unload files in the KM patch.

 3. Make a backup of your schemastub.xml file under directory <SM server>/RUN/km/styles/.

Backout
After installing the patch, do the following to backout:

 1. Stop your KM search engine.

 2. Remove the existing search engine installation folder.

 3. Copy the backup folder back.

 4. Rollback the previous JDK installation and change the JAVA_HOME environment variable back.

 5. Be sure to roll back KM related changes on the Service Manager server and application sides, 
including the kmsolr unloads files and the server's schemastub file.

 6. Restart your KM search engine.

 7. Perform a full re-indexing on all of your knowledgebases.
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Installation notes
This section provides instructions on installing each component in this patch release. You can also 
refer to the Service Manager 9.33 Upgrade Documentation Center, which is available to download 
from the following HP Software Manuals website: 

http://support.openview.hp.com/selfsolve/document/KM00729516

Before you proceed, HP recommends that you consult the latest Service Manager 9.33 Support 
Matrix and the Compatibility Matrix for Service Manager Applications Content. These are available 
at the following website:

http://support.openview.hp.com/sc/support_matrices.jsp

For more information, see "Service Manager Support Matrix and Applications Content Compatibility 
Matrix" on page 47.

Digital signature notice
HP signs Windows executable files with a digital signature. Since January 2012, this process has 
been updated to use a new VeriSign root certificate. On a Windows system that does not have the 
new VeriSign root or intermediate certificate installed, when the user right-clicks the file and then 
goes to Properties > Digital Signatures > Details, the following verification error is displayed: 

The certificate in this signature cannot be verified.
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To resolve this issue, either enable Windows Update or download and install the G5 Root certificate 
as documented at: https://knowledge.verisign.com/support/ssl-certificates-
support/index?page=content&actp=CROSSLINK&id=SO19140

Server update installation
The server update for your operating system consists of a compressed file, sm9.33.2003-P2_
<OS>.zip (or .tar), which contains updated files of the Service Manager server. These files add to or 
replace the files in the [SM Server Root]\([SM Server Root]/)RUN, irlang, bin, legacyintegration, 
and platform_unloads directories. 

Note: If you use an Oracle RDBMS, be aware that Oracle Call Interface (OCI) 11.2.0.3 is 
required for Service Manager 9.30p5, Service Manager 9.31, Service Manager 9.32 and later. 
For more information, see the latest Service Manager 9.33 Support Matrix at 
http://support.openview.hp.com/sc/support_matrices.jsp. 

Built-in troubleshooting tool (SM Doctor)
Additionally, as of Service Manager 9.32, the server patch includes an installation of the HP 
Service Manager Doctor (SM Doctor) tool. The server patch will install the tool in the <SM server 
root>\(<SM server root>/)smdoctor directory. For information on how to use this tool, see the 
Guides and reference > Troubleshooting > HP Service Manager Doctor section in the online help.

Upgrade paths
This server patch must be applied on top of one of the following versions/patch levels of the Service 
Manager server:

 l Service Manager 9.30 GA, and 9.30 Patch/Hotfix

 l Service Manager 9.31, and 9.31 Patch/Hotfix

 l Service Manager 9.32, and 9.32 Patch/Hotfix

 l Service Manager 9.33, and 9.33 Patch/Hotfix

The following server upgrade paths are recommended:

 l New customers: Install the Service Manager 9.30 GA server, and then directly apply this server 
patch.

 l Existing SC6.2, Service Manager 7.11 and  9.21 customers:  Uninstall the old server, install 
the Service Manager 9.30 GA server, and then apply this server patch.

 l Existing Service Manager 9.30,  9.31,  9.32, and 9.33 customers: Apply this server patch.

The installation steps are similar to those of Service Manager 9.33. For installation instructions of 
the Service Manager 9.33 server, see the Service Manager 9.33 Upgrade Documentation Center, 
which is available to download from the following HP Software Manuals website: 
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http://support.openview.hp.com/selfsolve/document/KM00729516

For installation instructions of the server patch, see "Server patch installation steps" below.

Compatibility mode for installation on Windows Server 
2012

As of Service Manager 9.32, Windows Server 2012 is supported. Be aware that compatibility mode 
is required for installing the Service Manager 9.30 GA server on Windows Server 2012 (not required 
for Windows Server 2008). To run your server installation in compatibility mode, do the following:

 1. Right–click the server's setupwin32.exe file icon.

 2. Click Properties > Compatibility.

 3. Click Run this program in compatibility mode for, and then select Windows Vista 
(Service Pack 2).

 4. Click Apply, and then click OK.

 5. Run the setupwin32.exe file to complete the installation.

When you uninstall your server on Windows Server 2012, you should also use compatibility mode. 
To do this, set your Windows server uninstaller file (_uninst\uninstaller.exe) to compatibility mode 
as described above, and then uninstall the server using the uninstaller or Control Panel.

Server patch installation steps

Caution:  

 l The server patch will upgrade your embedded Tomcat to version 6.0.37, and therefore 
requires additional steps.

 l The server patch will upgrade your JGroups (in the RUN/lib directory) to version 3.2. 

 l Starting with Service Manager 9.31p2, the Service Manager server requires JRE 1.7. For 
Windows and Linux,  the embedded JRE has already upgraded to version 1.7; for other 
Unix-based platforms, you need to manually perform this JRE upgrade. 

The JRE upgrade will cause external web service calls over SSL to fail if the remote 
endpoint does not support Server Name Indication (SNI), which is by default activated in 
JRE 1.7. Once Service Manager is upgraded to use JRE 1.7, it starts to use SNI 
extensions during the SSL handshake. If the remote endpoint does not support SNI, the 
web service call will fail with an error message. To solve this issue, do either of the 
following: 
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 n Activate SNI at the remote end point (recommended)

 n If the remote endpoint does not support SNI extensions, and SNI cannot be activated, 
add the following JVMOption<n> parameter either to the sm.ini file, or to the start 
command of the servlet(s) in the sm.cfg file:

JVMOption2:-Djsse.enableSNIExtension=false

Note: If you have a horizontally-scaled system, you must upgrade all your server instances.

 1. Stop all Service Manager clients.

 2. Stop the Service Manager server.

 3. Make a backup of the Server installation directory. See also "Backup and backout instructions" 
on page 25.

 4. Delete the RUN/tomcat directory. Tomcat in this directory will be upgraded to version 6.0.37 
when you extract the server files later.

 5. Delete the RUN/lib directory.

 6. For Windows and Linux platforms, delete the RUN/jre directory. 

Note: This step is required only when you are upgrading from a server version earlier than 
9.31p2. This is to avoid conflicts between the old 1.6-based JRE and new 1.7-based JRE.

 7. Extract the compressed files for your operating system into the main Service Manager 
directory on the server. By default, the file is saved in the following location:  

C:\ProgramFiles\HP\Service Manager 9.30\Server

 8. For UNIX servers, set the file permissions for all Service Manager files to "755."

 9. For the following Unix servers, manually upgrade to one of the following JRE versions, if you 
have not already done so.
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 a. Install either JRE1.6, or JRE1.7, as appropriate for your platform.

Solaris 9 JRE1.6 (update 20 or greater)

Solaris 10 JRE1.7 (update 45 or greater)

HP-UX JRE1.7 (JRE_7.0.07 or greater)

AIX JRE1.7 (SR6 or greater)

 b. Set your JAVA_HOME environment variable to point to JDK (if you have JDK installed) or 
JRE (if you have only JRE installed).

 c. Execute \RUN\removeLinks.sh to remove the old symbolic links and then execute 
\RUN\setupLinks.sh to create new symbolic links.

 d. Run the following command to check that the JRE version is correct: 

RUN\jre\bin\java –version

 10. If you have made any customizations/changes to the original RUN/tomcat folder, restore them 
in the new RUN/tomcat folder.

 11. Your old schemastub.xml file (in the <SM_Server_Home>\RUN\km\styles\ directory) has 
been updated to a newer version. Either keep your old file by copying it back or keep the 
updated version (a KM knowledgebase full reindexing is then required).

 12. Run the sm -unlockdatabase command.

Note: This step is required the first time you upgrade to 9.30p4 or later; it is also required 
whenever you change the server’s IP address after your upgrade to 9.30p4 or later. The 
purpose of this step is to prevent stale license information from being kept in the system. 
In a scaling implementation, you can run this command from any one of your servers.

 13. Restart the Service Manager server.

 14. Restart the Service Manager clients.

 15. Verify the version using either of the methods:

 n From the Windows client, click  Help > About Service Manager Server. The server 
version should be: Release 9.33.2003 build P2. 

 n From the server's RUN folder, run the sm -version command. The server version should 
be: 

Version: 9.33.2003 

Patch level: P2 
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Web tier installation
The web tier update consists of a compressed file, sm9.33.2003-P2_Web_Tier.zip, which contains 
the installation files (both the .war and .ear files) that are required to install the Service Manager 
9.33p2 web tier. Installing the new web tier will upgrade your web client to this release level.

The installation steps are similar to those of version 9.33. See the Service Manager 9.33  Upgrade 
Documentation Center, which is available to download from the following HP Software Manuals 
website: 

http://support.openview.hp.com/selfsolve/document/KM00729516

New customers
You only need to install the new web tier using the .war or .ear file from the sm9.33.2003-P2_Web_
Tier.zip file in this release. 

Existing customers
To upgrade your web tier to this patch level, you must back up and uninstall your old web tier, and 
then install the new web tier.  The upgrade does not automatically save your web tier 
customizations. To keep your changes, you must back up your customized files and restore your 
customizations in the new deployment.

Note: If you plan to deploy the web tier on Tomcat 7.0 by using the Tomcat Manager, you must 
set the max-file-size and max-request-size parameters (default: 52428800) in the <Tomcat 
7.0_Home>webapps\manager\WEB-INF\web.xml file to a value greater than the size of the 
web tier .war file, otherwise the deployment request will be rejected because the web tier .war 
file exceeds the default maximum values. This restriction does not exist in Tomcat 6.0.

To install the new web tier, follow these steps:

 1. Make the necessary backups. For more information about how to do this, see "Backup and 
backout instructions" on page 25.

 2. Delete or uninstall the existing web tier .war (or the .ear) file.

 3. Clear the cache of your web application server.

 4. Deploy the new webtier-9.33.war (or .ear) file by following the instructions in the Service 
Manager 9.33 Upgrade Documentation Center.

Note: It is best practice to deploy with a unique context root. For example, /webtier-
sm9.33.2003-P2.

 5. Use a diff utility to compare the new web tier’s web.xml file against your backed-up version to 
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ensure that any new parameters are properly merged into the files used in your final 
deployment. Do this for application-context.xml as well as any other files you may have 
customized (such as style sheets and splash screens).

 6. Make any new customizations that are necessary for your deployment.

 7. Restart the web application server.

 8. Check the version by clicking the HP logo (About HP Service Manager) icon.

The web tier version should be: sm9.33.2003-P2.

Windows Client Installation

Note: No features are being added to the Service Manager Windows (Eclipse) client.  HP 
recommends that Service Manager administrators deploy one of the other three clients (web 
client, SRC client or Mobility client) to end users.  You still need the Windows client to perform 
administrative tasks.

The Windows client update consists of a compressed file, sm9.33.2003-P2_Windows_Client.zip, 
which contains the executable installation files of the new Windows client. Installing the new 
Windows client will upgrade your Windows client to this patch level.

For installation instructions, see the Service Manager9.33 Upgrade Documentation Center, which 
is available to download from the following HP Software Manuals website: 

http://support.openview.hp.com/selfsolve/document/KM00729516

New Customers
You only need to install the new Windows client.

Existing Customers
You need to back up and uninstall the old Windows client, and then install the new Windows client. 

To install the new Windows client:

 1. Stop the Service Manager Windows client.

 2. Make necessary backups. For details, see "Backup and backout instructions" on page 25.

 3. Uninstall the Service Manager Windows client. (Your connection and personalized settings are 
retained.)

 4. Run setup.exe from this Windows client patch to install the new client.
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 5. Check the version in Help > About Service Manager Client.

The client should be Release: 9.33.2003-P2.

Windows Client Configuration Utility installation
This release does not contain any updates to the Windows Client Configuration Utility. You can 
download the latest Windows Client Configuration Utility shipped with the Service Manager 9.33 
release.

You can find the download links for the SM9.3x patches and release notes from knowledge 
document Overview of Service Manager 9.3x Releases:

http://support.openview.hp.com/selfsolve/document/KM00705452

Applications Update installation
This release does not contain any updates to the Service Manager 9.33 applications. You can 
download the latest applications shipped with the Service Manager 9.33 release.

You can find the download links for the SM9.3x patches and release notes from knowledge 
document Overview of Service Manager 9.3x Releases:

http://support.openview.hp.com/selfsolve/document/KM00705452

Application Unload installation

Note: All unload files in the server’s platform_unloads directory in this release have been 
already merged into the Service Manager 9.33 applications. These files are provided just in 
case you do not plan to upgrade to applications 9.33 while still want to take advantage of the 
relevant new features/fixes.

If a platform fix (in most cases, a server fix) also requires an applications change to resolve the 
relevant issue, an unload file is provided. Unload files introduced in earlier patches are also included 
in this cumulative release. If you have not already applied them for a previous patch, you should 
also apply the unload files that are intended for your applications version. For more details about 
these applications updates, see the Release Notes for those patches.

This patch release includes the unload files that come with the server update. When you extract 
sm9.33.2003-P2_<OS>.zip (or .tar), it will add the files to the following directory:

[SM Server Root]\platform_unloads ([SM Server Root]/platform_unloads)

Note: Unload files should be installed in their patch order. That is, those introduced in patch 1 
should be applied first, then those introduced in patch 2, and so on. However, unload files 
introduced in the same patch can be installed in a random order, unless otherwise specified.

Unload file naming convention
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The unload files use the following naming convention: <CR_ID>_SMxxxPxx_SMxxx.unl, where:

 l <CR_ID>: The identification number of the applications defect that the unload file fixes. For 
example, QCCR1E12345. 

 l SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For 
example, SM921P2, which means the unload file comes with the server updates in Service 
Manager 9.21 patch 2 and should be used for patch 2 or higher.

Note: Sometimes this portion contains an additional hot fix number, for example, 
SM711P16HF8. This example means the unload file is intended for Service Manager 7.11 patch 
16 Hot Fix 8 or higher.

 l SMxxx: The Service Manager applications version that requires the unload file. For example, 
SM711, which means the unload file is intended only for Service Manager applications version 
7.11.

Note: If the applications version suffix is omitted, the unload file is then intended for all 
applications versions compatible with the server version, unless otherwise specified. For 
example, QCCR1Exxxx_SM930P4.unl is normally intended for applications versions 7.11, 
9.20, and 9.30 (which are compatible with Service Manager server 9.30), unless otherwise 
specified in the unload file description. For information on the applicable applications 
versions for each unload file included in the current patch, see Unload Files Included in the 
Current Patch.

Unload files included in the current patch

The following are unload files included in the current patch release.

Unload file

Introduc
ed in  
9.3x 
patch

Used for 
apps 
version
(s) Description

QCCR1E9914
7_SM933_
SM930.unl

9.33 9.30, 
9.31, and 
9.32

Fixes an issue in which the first tab of a Notebook is 
reset to be the active tab when a new interaction is 
opened through the "Return to blank interaction" 
environment settings.

Associated server fix: QCCR1E99147

QCCR1E9939
8_SM932P2.unl

9.32p2 7.11, 
9.21, 
9.30, and 
9.31

Enables the inactivity timer function to work correctly 
when the version of applications is lower than the 
version of the server.

Associated server fix: QCCR1E99398
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Unload file

Introduc
ed in  
9.3x 
patch

Used for 
apps 
version
(s) Description

QCCR1E1994
6_SM933.unl

9.33 7.11, 
9.21, 
9.30, 
9.31, and 
9.32

Enables extra columns in the "Attachments" section 
of records.

Associated server fix: QCCR1E19946

QCCR1E3132
4_SM932.unl

9.32 7.11, 
9.21, 9.30 
and 9.31

Fixes this issue : With Syslog audit turned on, only a 
syslog record showing login is created; no record for 
logoff is recorded if the user does not log out 
"normally."

Associated server fix: QCCR1E31324

QCCR1E9680
2_SM931P3.unl

9.31p3 7.11, 
9.21, 9.30 
and 9.31

Changes the behavior when handling web service 
request user passwords. See the Service Manager 
9.31p3 Release Notes.

Associated server fix: QCCR1E96802

QCCR1E5276
7_SM931P3_
SM930.unl

9.31p3 9.30 Fixes the issue that users cannot add data policy 
definitions on joined tables. 

Note: You do not need to load this unload if you are 
running on Service Manager 9.31, 9.21, or 7.11 
applications.

Associated server fix: QCCR1E52767

QCCR1E7672
4_SM931P2_
SM930.unl

9.31p2 9.30 and 
9.31

Fixes the issue that after deleting the unique key of 
cm3r, a signal 11 happened while doing an IR 
regeneration.

Associated server fix: QCCR1E76724

QCCR1E7622
7_SM930P6_
SM930.unl

9.31 9.30 Contains the code changes to support localization of 
incident/change priority and urgency strings for the 
9.31 Mobility Client.

Note: Not needed for the Service Manager 9.32 
or later Mobility client.
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Unload file

Introduc
ed in  
9.3x 
patch

Used for 
apps 
version
(s) Description

QCCR1E7879
4_SM930P6_
SM930.unl

9.31 9.30 Removes incident.assignee when a Web Service call 
specifies the assignee as 'NULL' through the Service 
Manager9.31 Mobility Client.

Note: Not needed for the Service Manager 9.32 
or later Mobility client.

QCCR1E7679
6_SM930P6_
SM930.unl

9.31 9.30 Provides the ability to turn on debugging dynamically 
for user sessions or schedulers.

Note: This unload requires the Service Manager 
9.31 server.

QCCR1E7109
9_SM930P5_
SM711.unl

9.30p5 7.11 Displays Value Lists instead of the data directly 
retrieved from the database in a QBE list when adding 
a field by using Modify Columns.

Associated server fix: QCCR1E71099

QCCR1E7109
9_SM930P5_
SM920.unl

9.30p5 9.20 Displays Value Lists instead of the data directly 
retrieved from the database in a QBE list when adding 
a field by using Modify Columns.

Associated server fix: QCCR1E71099 

QCCR1E7109
9_SM930P5_
SM930.unl

9.30p5 9.30 Displays Value Lists instead of the data directly 
retrieved from the database in a QBE list when adding 
a field by using Modify Columns.

Associated server fix: QCCR1E71099 

QCCR1E7113
9_SM930P5_
SM930.unl

9.30p5 9.30 Works with server fix QCCR1E71139 to solve this 
issue: When Service Manager is configured to use 
LDAP as the authentication data source, the user is 
still forced to change the password if the user is 
expired in the local database.
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Unload file

Introduc
ed in  
9.3x 
patch

Used for 
apps 
version
(s) Description

QCCR1E3194
1_SM930P4_
SM930.unl

9.30P4 9.30 Enables users to use a pre-configured decimal 
symbol when completing numeric fields. 

Note: This enhancement requires a 9.30p4 or 
later server; however if you are using RTE 
version 9.30 with applications version 7.11 or 
9.20, do not load this unload file; you can safely 
upgrade your server to 9.30p4 or later without 
applying this applications change.

Associated server fix: QCCR1E31941.

QCCR1E7345
2_SM930P4.unl

9.30P4 7.11 - 
9.30

Enables Mandanten restricting queries to be updated 
correctly after a profile is edited.

Associated server fix: QCCR1E71897

QCCR1E6707
2_SM930P4_
SM930.unl

9.30P3 7.11 and 
9.20

Enables users to take advantage of the new 
KMStatusListener background process.

Note: This unload file is not needed for 
applications version 9.30 or later, which supports 
only the Solr Search Engine.

Associated server fix: QCCR1E67071

QCCR1E7016
3_SM930P4_
SM711.unl

9.30P3 7.11 Fixes the issue that the KMUpdate process 
terminates abnormally.

Associated server fix: QCCR1E69687

QCCR1E7016
3_SM930P4_
SM920.unl

9.30P3 9.20 Fixes the issue that the KMUpdate process 
terminates abnormally.

Associated server fix: QCCR1E69687

QCCR1E7016
3_SM930P4_
SM930.unl

9.30P3 9.30 Fixes the issue that the KMUpdate process 
terminates abnormally.

Associated server fix: QCCR1E69687
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Unload file

Introduc
ed in  
9.3x 
patch

Used for 
apps 
version
(s) Description

QCCR1E6764
7_SM930P3.unl

9.30P3 7.11 - 
9.30

Updates the exception message that occurs in the 
request response when closing an interaction by 
calling CloseInteraction from a web service without 
specifying the localSolution field in the request.

Associated server fix: QCCR1E54192

QCCR1E6761
0_SM930P2.unl

9.30P2 7.11 - 
9.30

Enables you to block potentially dangerous 
attachments.

Associated server fix: QCCR1E64290

Loading unload files

Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are 
recommended to use Unload Manager to load an unload file, because Unload Manager can 
help you create a backup of your old data and reconcile conflicts during the installation of the 
unload; if your application version is other than any of these, Unload Manager is not available 
and you can use Database Manager instead. 

To load an unload file using Unload Manager:

 1. Go to System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details 
of the unload file appear.

 4. Double-click a conflicting object in the table to open the merge tool:

 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to go back to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the unload.

 7. Click Finish. 

Now, the unload has been applied and at the same time your old data backed up.

To load an unload file using Database Manager:
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 1. Make sure the Windows client is configured for server-side load/unload.
 a. From the Windows client, go to Window > Preferences > HP Service Manager.

 b. Unselect Client Side Load/Unload if is flagged.

 c. Restart the Windows client.

 2. Open Tailoring > Database Manager.

 3. Right-click the form or open the More Actions menu and select Import/Load.

 4. Browse to the unload file, and view the contents of an unload file before importing it by clicking 
List Contents.

 5. Make a backup copy of all files to be modified by this unload. For detailed steps, see "Backup 
and backout instructions" on page 25.

 6. Fill in the following fields.

Field Description

File Name Type the name and path of the file to 
load.

Import Descriptor Since unload files do not require an 
Import Descriptor record, leave this 
field blank.

File Type Select the source operating system of 
the unload file.

Messages Option —  

All Messages Select this option to see all messages 
that Service Manager generates 
loading the file.

Messages Option —  

Totals Only Select this option to see only the total 
number of files Service Manager 
loads.

Messages Option — 
None

Select this option to hide all 
messages that Service Manager 
generates when loading the file.

 7. Click Load FG.
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Service Request Catalog (SRC) installation
This release does not contain any updates to SRC. You can download the latest SRC shipped with 
the Service Manager 9.33 release.

You can find the download links for the SM9.3x patches and release notes from knowledge 
document Overview of Service Manager 9.3x Releases:

http://support.openview.hp.com/selfsolve/document/KM00705452

Mobile Applications  installation
Service Manager 9.33 patch 2 includes a new version of the Mobility client (sm9.33.2001_
Mobility.zip). New customers can directly install the new Mobility client by deploying the webapp-
9.33.2001.war file, while existing customers can only uninstall their old Mobility client and then 
install the new one.

For more information about how to install the Service Manager 9.33  Mobility client, refer to  the 
Service Manager 9.33 Mobile Applications User Guide.

Application changes required for Service Manager 9.31 and for Service Manager 9.30

The Service Manager 9.33 Mobility client can work with the Service Manager 9.33, Service 
Manager 9.32, Service Manager 9.31, or Service Manager9.30 applications; however, if using the 
Service Manager 9.31 or Service Manager 9.30 applications, before users can use the Mobility 
client, you ,as an administrator, need to make additional application changes by either importing or 
manually implementing the unload files shipped with the Mobility client package (be sure to import 
or implement them in listed order):

 l mobile2-update-9.30-9.31.unl

 l mobile2-new-9.30-9.31.unl 

 l mobile2-new-9.31-pd4.unl

For details, see the Service Manager 9.33  Mobile Applications User Guide.

Knowledge Management (KM) update installation
This release does not contain any KM updates. You can download the latest KM package shipped 
with the Service Manager 9.32 release.

You can find the download links for the SM9.3x patches and release notes from knowledge 
document Overview of Service Manager 9.3x Releases:

http://support.openview.hp.com/selfsolve/document/KM00705452
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ODBC Driver update installation
This release does not contain any ODBC Driver updates. The latest ODBC Driver package  has 
been shipped with the Service Manager 9.30p4, SerService Manager 9.30p5, and Service Manager 
9.31 releases.

You can find the download links for the SM9.3x patches and release notes from knowledge 
document Overview of Service Manager 9.3x Releases:

http://support.openview.hp.com/selfsolve/document/KM00705452

Language Pack installation
This release does not contain any language pack updates. You can download the latest language 
packs shipped with the Service Manager 9.33 release.

You can find the download links for the SM9.3x patches and release notes from knowledge 
document Overview of Service Manager 9.3x Releases:

http://support.openview.hp.com/selfsolve/document/KM00705452

Online Help installation
This release does not contain any online help updates. You can download the latest online help 
shipped with the Service Manager 9.33 release.

Service Manager 9.33  includes only an English version of the online help. For installation 
instructions, see the Service Manager 9.33 Interactive Installation Guide that is included in the 
Service Manager 9.33 Upgrade Documentation Center. This is available to download from the 
following HP Software Manuals website: 

http://support.openview.hp.com/selfsolve/document/KM00729516

You can download the Service Manager 9.33 online help from the following website:

http://support.openview.hp.com/selfsolve/document/KM00729523
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Service Manager Support Matrix and 
Applications Content Compatibility Matrix

The Support Matrix lists supported versions of operating systems, browsers, HP Software 
products, and other compatibility and support information.

The Applications Content Compatibility Matrix (named Compatibility Matrix for Service Manager 
Applications Content) provides compatibility information for Service Manager applications content 
packs (for example, Process Designer Content Packs). 

Note: Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require an active support contract. To find more information about support access levels, go to      
Access levels.

To register for an HP Passport ID, go to      HP Passport Registration.

To access the Support Matrix and Applications Content Compatibility Matrix:

 1. Use a browser to navigate to the Software Support Online (SSO) web page:

http://support.openview.hp.com/sc/support_matrices.jsp

 2. Log on with your Customer ID and password or your HP Passport sign-in.

 3. Navigate to the applicable information.
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